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1.0 Introduction 

 

 

CALDES Developer is the Estate Gazette‟s most highly rated Windows-based development 

appraisal, discounted cash flow and project monitoring system. It has many features that set it 

apart from other appraisal systems including its unique Development Setup Wizard and its 

ability to work directly with live spreadsheets. 

 

Having entered your essential data using the Setup Wizard, CALDES constructs 7 fully 

interconnected spreadsheets. The programmes‟ framework then intuitively guides‟ novice users 

through the development process, while spreadsheet flexibility allows extensive programming 

for the more adventurous. 

 

A brief description of each of the spreadsheets is given below, and on the next few pages 

examples of printouts available from the programme are shown. Each spreadsheet has been 

carefully developed to provide for a specific purpose, be it an appraisal, cashflow, sales 

schedule, construction schedule or a list of fees, rates or timings. 

 

Appraisal Summary Spreadsheet 

A clear and concise standard Appraisal, listing all the main incomes and costs and a set of 

summary results, such as Profit on Cost, Internal Rate of Return and Net Present Value. A copy 

can be re-formatted in propriety Excel for adding to standard reports or sending to clients via 

Email. 

 

Land Spreadsheet 

A summary of project and land information, allowing multiple tranches of land to be dealt with 

simultaneously. 

 

Overalls Spreadsheet 

A breakdown of overall fees and rates, 2 timings with tools to automatically spread the timing 

of payments and interest. 

 

Cash Flow Spreadsheet 

A familiar spreadsheet cash flow, interchangeable between both monthly and quarterly periods. 

Complex financial deals can easily be set-up, with VAT available on every item. Interest rates 

and proportions can be altered to meet variable changes throughout the life of the project. 

 

Sensitivity Analysis Spreadsheet 

Up to 3 axes can be selected, and analysed from a long list of variables including timings and 

building sizes. 
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Proprietary Spreadsheet 

This can be used as a gateway to other Windows systems and most property software. You can 

even build up your own Microsoft Excel© Spreadsheets via Add-ins. Modules currently 

include:  

 

 Accounting Link (NEW) 

 Combined Cash Flow  

 Zoned Retail  

 Hotelier  

 Actual v Budget  

 Customised Solutions 

 

For details on any of these modules or to arrange a demonstration of CALDES Developer 

please contact our Head Office on +44 (0) 870 420 8348. 
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1.1 DISK INSTALLATION 

 

 Insert the CD-ROM 

 Start Windows 

 Choose RUN from the File Manager 

menu or Start Menu in Windows 

 Type: d:/setupdv and then press OK 

 Press OK and follow the on screen 

instructions. 

 Once installed run the program by 

double clicking on the CALDES 

Developer Icon in the CALDES 

Development Software Group that is 

on your desktop (or under the Start 

Menu in Windows) 

 

 
 

 You will then be asked for a 

password.  This changes on a 

random basis, so you will need to 

call us at this point, with the Security 

Dialogue Box on screen (0870 420 

8348.).  If we are not available just 

press OK and cancel the software 

until later. 
 

1.2 Network Installations 

 

Please refer to Appendix – A for 

information on Installing CALDES 

Development Valuer on to a Network.   

 

Important! 

This tutorial has been designed as a 

starting point and we suggest that it 

should be read whilst using the system, 

not on its own.  If the manual does not 

answer your query please feel free to 

call CALDES on +44 (0) 20 7439 4995 

 

2.0 ABOUT THE SYSTEM 

 

2.1 The CALDES Pyramid System 

 

 The system is split into three areas 

and grows in functionality and 

flexibility using what we have called 

the “Pyramid System.”  This means 

that to start with, much of this 

manual will not be required. 

 

 Initially CALDES provides you with 

the bare essentials of a development, 

and allows you to expand to an 

almost unlimited extent. 

 

 

2.2 The Development Setup Wizard 

and Database 

 

 Stores frequently used variables such 

as rents and building costs, fees and 

interest rates.   

 

 (To Quit CALDES completely here 

select the "Finish Setup" bottom tab 

and then the "Quit CALDES" 

button.) 

 

 

2.3 Spreadsheets 

 

 For storing and fine tuning 

Appraisals and Cash Flows. 

 

 (To Quit CALDES completely here 

use the File Menu and Exit.) 

 

 

2.4 The on-line help system 

 

 Press F1 for help on the current 

subject, whilst using the program.   
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 To quit the help system completely, 

use the File Menu and Exit. 

 

 

3.0 THE DEVELOPMENT 

SETUP WIZARD  

 

 The following tutorial shows you 

how to produce a full spreadsheet 

based development appraisal and 

cash flow to meet an individual 

development scenario without time 

consuming copying and pasting of 

spreadsheet rows and columns and 

constant checking of formula - Use 

the CALDES Development Setup 

Wizard! 

 

 Please note that this is only used to 

set up the initial project.  You can 

extend the project to an almost 

unlimited extent using the “Pyramid 

System” (see above.) 

 

 To follow our tutorials use the 

figures in brackets or pictures 

shown. 
 

 

 

3.1 Basic features 

 

 For additional help whilst using 

CALDES select the New User Help. 
 

 

This will give you on screen prompts 

whilst entering data. 

 Set Up Style.  Click on the arrow for 

a selection of different use type 

scenarios. For instance, select 

Residential and your spreadsheets 

will be “Set Up” to give a more 

residential feel, including bedrooms 

and bathrooms. 

 You can define what is shown and 

what is hidden in the Defaults 

spreadsheet in the main spreadsheet 

section. (See section 15) 

 
3.2 Basic Site Information 

Development Setup Wizard:  
 

 Essential project information is 

added to the Land Information box.   

 

 This includes an eight-letter file 

name (so that the files remain 

compatible with all versions of 

Windows). No full stops, commas, 

hyphens or question marks can be 

used. 

 

 The Project Start date is also entered 

on this screen: This is the date that 

when the first payment is made. 

Initially CALDES assumes that this 

is the land purchase date although, 

this can be changed later in the land 

spreadsheet. Check that the date is 

the current month.  If not then your 

computer clock is wrong.  This is the 

only real date in the whole system.  

Once set all other dates are whole 

months from this date. 

 

 Add either a Land Value, a preferred 

profit on cost or a Development 

Yield (Further options are available 

through the Sensitivity Analysis). 
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3.3 Basic Project Information & 

Phasing 

 

 Decide whether you want to phase 

the project.  

 

 For the purposes of this Tutorial we 

have selected to do an unphased 

development. 

 

3.31 Unphased Option 

 

 

 

Add the number of months from 

project start to construction start in 

the “Start Month” box. (2) (Prebuild 

period) 

 

Type in the number of months for 

construction, including the start 

month. (12) 

 

Type the void between the end of 

practical completion/construction to 

the last sale (6) 

 

Simple Phased Option: Up to 7 

Phases 

 

1. Ignore the boxes shown in the 

overalls section and click on the 

“Phase?” button instead. 

 

2. Add in each phase exactly as for the 

phased option. The difference is that 

you can add up to 7 phases. You 

must work through each phase in 

order from the top only. 

 

3. Click “OK”. You have now fixed 

your phases, but they can be 

changed later on in the Unit 

Breakdown Spreadsheet. You will 

note that you can no longer change 

the simple phased option. 

 

 
 

4. Now allocate each unit to a phase 

using the dropdown box, which will 

be showing, in the unit area next to 

the unit type. 

 

3.33 Complex Phased Option: Up to 

250 Phases 

 

 Set up a simple phased scheme and 

then change each individual unit in 

the Unit Breakdown spreadsheet. 

(See Section 11.0) 

 

3.34 Interest Rates 

 

 Check the main interest rate.  (You 

can also add multiple sources, 

variable on a monthly basis from the 

Cash Flow Spreadsheet. See Section 

12.0. (8) 
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3.4 Basic Unit information 

 

 
 

 Select a building type by clicking on 

the arrow and selecting a unit from 

the drop down box. Pick the use type 

that most closely matches your unit 

or floor of the unit.  (You can change 

the actual name / floor of the unit 

later in the Unit Breakdown 

spreadsheet. i.e. B1 could be 

renamed as Office. (B1)) 

 

 Check the areas, rents and costs.  

Please note that you can use this 

section as a calculator, locking 

specific cells.  For instance, locking 

your gross to net ratio will mean that 

any changes made to the gross area 

will change the net area.  You can 

define the names of these areas in 

the spreadsheet areas later, allowing 

for the mix of terminology used 

between residential or commercial 

development. The “No. Multi Units” 

acts as a multiplier, allowing you to 

build up large schemes without 

adding each individual unit.  Only do 

this if the unit areas and construction 

costs are the same.  (You can 

schedule sales of grouped units in 

the Unit Breakdown spreadsheet.) 

All default figures can be edited in 

the main Appraisal Defaults section. 

 

 
 

 To add any additional units or floors 

click the “More Units” button.  Note 

that this will bring up a list of units 

with areas, rents and costs.  At this 

stage you can not delete items once 

added. (You can delete them later by 

selecting the item to delete in the 

Appraisal and then using the 

Spreadsheet Control menu.) 

 

 
 

 Important!  The current unit shown 

will already be added to your 

scheme.  This means that you only 

click “More Units” to add another 

unit.  Note how the unit Number 

changes at the top. 

 

 

 

3.5 Bullet Payments 

 

 To add any other costs or revenue 

select the appropriate button.  These 

will be added as “bullet payments” 

to the appraisal and cash flow. 

 

 Note that this excludes fees and 

VAT, which are dealt with in 

sections 4.0 and 5.0. Also, 

marketing and rent-free periods are 

dealt with in section 11.0. 
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 Having selected one of the above 

buttons you will be shown the 

following screen: 

 

 Type in the name of the payment, 

how much, when it happens and over 

what period of time you would like 

to spread it. If you want to spread 

these cost over a more elaborate time 

frame you can literally type over the 

amounts in the cash flow later. 

(30,000 in month 1 spread over 2 

months) 

 

 To add further items click “Next 

(Add another Item)” otherwise click 

“Add Item and finish.” Alternatively, 

if you click “Cancel (current item 

and finish)” you can delete your last 

item and return to the previous 

screen. At this stage you can not 

delete items that have already been 

added. Although, you can delete 

items later by selecting them in the 

in the Appraisal Spreadsheet and 

then selecting: “Spreadsheet 

Control-> Delete Selected 

Unit/Payment/VAT.” 

 

(30,000 in month 1, Spread over 2 

months) 

 

 

 

4.0 VAT Defaults 

 

 The VAT default section allows you 

to set up a standard range of starting 

figures for VAT.  The left-hand 

figure is the percentage of each 

item‟s cost that has VAT on it.  This 

is usually 0 or 100.  The right hand 

figure is a percentage of the left-

hand percentage recovered. This 

will almost always be 0 or 100. 

Once set up, the VAT section can 

be left.  It only needs to be changed 

if you change from say residential, 

where both boxes in construction 

will usually be 0, to commercial 

where they will usually be 100.  For 

mixed use schemes leave them as 

100 and then change the residential 

units only back to 0 in the cash flow 

if required.  

 

 You can change VAT on any 

individual item from the Cash Flow 

spreadsheet. (See Section 12.4 VAT 

in the Cash Flow). 

 

 
 

 When setting up a new development 

you are forced to use these figures.  

If you return to this screen from an 

existing project you may force all 

items in each section to a different 

setup with the Use or Ignore option. 
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 Remember to check the VAT rate 

and number of months to recovery.  

You will see recovered VAT with a 

“-R” in the Cash Flow. 

(100 in all exc. Proceeds and Land) 

 

 

5.0 Overall Defaults 

 

 Please note that if you are on a 

network, then changing these figures 

for an individual project here will 

change them for all users. Therefore, 

it is advisable not to edit these here, 

but make changes in the overalls 

spreadsheet in the main appraisal. 

 To change items in this section you 

will need to unlock the restricted 

assess to defaults in the initial 

password section. Select „File‟ then 

untick the “restrict access to 

defaults”, you will then need a 

password which we will supply 

(0870 420 8348) .It is import to lock 

this area back down when you have 

made your adjustments. Use the 

same process to re-tick. 

 The Overalls spreadsheet is a mini 

database of project default figures.  

This provides a structured starting 

point to your development.  You can 

then expand to more detail in the 

spreadsheet areas if required.  Once 

set up you should not change them 

here each time you start a new 

project.  Change the matching 

figures in the Overalls spreadsheet 

instead. 

 

 The Project Construction Fee %‟s 

allow you to add initial fees for each 

main category. As these will vary  

 

from project to project, a percentage 

must be added.  Remember that 

these are starting figures for all new 

projects only.  You can change them 

to lump sum figures or add in more 

items in the Overalls Spreadsheet of 

the individual project later. 

 

 The Breakdown allows you to make 

a fast, simple spread of how these 

fees are paid. There are three 

different options to choose from at 

this point: 

 

 5 Stages: A simple spread of fees 

over the whole project period using 

the percentage system provided in 

the Overalls Defaults. (See Section 

10.0).  

 

 Pro Rata Construction Only: A 

spread of fees pro rata construction 

costs. (See Section 10.0). 

 

 Type Directly to Cash Flow: 
Unlocks the fees section of the Cash 

Flow Spreadsheet allows the 

greatest level of flexibility. (See 

Section 10.0). 

 

 Select the one that best suits your 

needs by clicking on the Radio 

Buttons at the bottom of the screen. 

For the purposes of this Tutorial a 

simple 5 Stage Spread is being 

used. 
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 If you change your mind about how 

you want your fees spread, you can 

always change this option from the 

Spreadsheet Control Menu later on 

in the program.  

 

 Non construction fee defaults are 

added to the “Other fees section.”  

Please add your own default figures 

here.  Planning and building 

regulation fees are nominal lump 

sum figures.   
 

 Letting fees will only be allocated to 

commercial uses unless otherwise 

specified in the Unit Breakdown 

spreadsheet, so you do not have to 

remove them for residential 

schemes. 

 

 Other costs such as marketing and 

rent-free periods can be added to 

each individual unit in the unit 

breakdown spreadsheet. (See Section 

11.0 Unit Breakdown.) 

 

 
 

 The Timings section allows you to 

detail which month, from the start of 

the whole project, in which planning, 

building regulations and marketing 

happen. Also for residential sales 

you can add a % of the sale as a 

marketing cost.  Remember that the 

construction and sales timings were 

set in the Development Set-Up 

Wizard at the beginning and can also 

be changed in the Unit Breakdown 

Spreadsheet for each individual unit. 

 

 The finance section defines how 

interest is calculated.  The 

compounding is fixed at this point, 

but can be manipulated in the Cash 

Flow Spreadsheet. 

 

 A standard Credit rate, if the bottom 

line of the cashflow becomes 

positive, may be used. 

 

 A net present value of your profit 

may be determined using the 

discount rate set here.  For a full 

definition of NPV and IRR, 

including exactly how they are 

calculated, select F1 in the help 

system.  We do not use the standard 

spreadsheet NPV formula, as there 
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have been concerns over its 

reliability. 

 

 

6.0 Initial appraisal 

 
 The Development is now set up - 

Where is my appraisal? 

 

 Select the "Finish Setup" Tab at the 

top of the screen. 

 

 Press the "Go to spreadsheet 

appraisal" button for a full 

spreadsheet based interactive 

appraisal and cashflow, with 

investment and project monitoring 

capabilities. 

 

 
 

 You will be presented with the 

appraisal showing a complete 

breakdown of all income and 

expenditure. For more information 

see Section 6.0 Initial Appraisal. 

 

 The net land value for our tutorial 

will be 1,915,839  (2,011,631 gross) 

Initially you will not be able to see 

the Net Figure.  See the Next section 

for more details. 

 

 
 

 To print, select the menu bar:     

“File->Print All.” and then from the 

Print option box select the Appraisal 

tab.  Then select the Print button and 

follow the prompts.  When complete 

click the Done tab to return to the 

spreadsheets area.  You have now 

done your first appraisal using 

CALDES.  To Fine tune the 

Development see the next section.   

 

 

7.0 SPREADSHEET AREA 

- An Overview 

 

7.1 The Menu Bar 

 

All functions available to each 

spreadsheet are available from the 

Spreadsheet Control Menu. In the 

outline below, when you see "->" that 

means a sub menu of the current menu. 

For instance the menu selection below 

would be " Spreadsheet Control-> 

Appraisal-> All Rows-> Show 

breakdown.” 

 
 

 

7.2 The Scroll Bars 

 

To move around the spreadsheets click 

on the arrows at the top and bottom or 

left and right of the spreadsheet area (if 

shown.). If they are not shown then 

click on the spreadsheet first.  If they 

are still not shown then the spreadsheet 

should not scroll in this direction. 

 

 
 

 

7.3 The spreadsheet tabs 

 

Along the top of the spreadsheets are a 

selection of buttons or "Tabs", which 

allow you to move to each spreadsheet. 
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7.4 Spreadsheet Overview 

 
 CALDES Spreadsheets are exactly 

the same as any other spreadsheet.  

We have provided a few rules below 

to make life easier. 

 

 Each spreadsheet has a specific 

function.  Generally the blue area is 

where the name/text for each row is 

displayed. This area will only 

move/scroll up and down, but not 

left and right. 

 

 Along the top will be the headings in 

white or Grey. These will move/ 

scroll left and right but not up and 

down. 

 White cells are where you type in 

your information. 

 

 Grey cells show results. 

 

 
 

 The current cell ref. is shown in the 

top left corner under the buttons. The 

current cell contents are shown in the 

bar to the right. 

 

 Notes can be added in the white cells 

to the right of most spreadsheet. You 

can view Spreadsheet Notes by 

selecting: “Help-> show 

spreadsheet notes.” 

 

 Press F6 on your keyboard to show 

the row and column headings. 

 

 Press F7 on your keyboard to hide 

the row and column headings. 

 

 Press F8 to force all spreadsheets to 

recalculate (This is not normally 

necessary, but can be used as a 

check.) 

 

 Use the Floating Eye button for a 

mini appraisal/sensitivity sheet, 

irrespective of the current 

spreadsheet. 

 

 

 
8.0 The Appraisal Summary 

Spreadsheet. 

 

 This is the first spreadsheet that you 

will see after using the Setup 

Wizard. You can not change 

anything from this spreadsheet. It 

only shows the results. (Land value, 

profit, IRR, NPV etc.) 

 

 All changes are made in the other 

spreadsheets. However, by double 

clicking on any figure, this will take 

you to the correct spreadsheet to edit 

the figures. 

 

 The Appraisal Summary will 

initially show a complete appraisal 

(including a breakdown of all fees 

and costs). To show totals only 

select the menu: “Spreadsheet 
Control-> Appraisal-> All 

Rows-> Hide (leave totals 

only).” 

 

 Important!  If you are ever unsure 

about whether a figure has been 

displayed in the appraisal use the 

"Spreadsheet Control -> 

Appraisal-> All Rows-> Show 

breakdown.” command to reset the 

appraisal.  This is because CALDES 

allows you to hide or display rows as 

required using the menu: 

"Spreadsheet Control -> 

Appraisal-> Show next row or 

Hide next row.” (For the bank 

etc.!) 

 

 This is a clear, standard appraisal 

where land value can be shown as 

part of the input figures or as a result 
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at the bottom.  To move land select: 

"Spreadsheet Control-> 

Appraisal-> Land-> Option 2: 

Show as a result" 

 

 To find the IRR you will need to 

select the Goal Seek Button: 

 

     
 

 To reset the profit or land cost you 

need to select the floating eye. 

 

9.0 The Land Spreadsheet. 

 

 To add up to 10 other tranches of 

land select: “Spreadsheet 
Control-> Land Spreadsheet-

>Show Tranch2” 

 

 
 

 Note that the Stamp Duty and land 

fees are also here.  You can add a 

percentage or a full amount.  Be sure 

to check that these figures meet 

current Stamp Duty requirements. 

 

 You can also add more tranches later 

using the menu:  "Spreadsheet 
Control-> Land-> Show Tranche 

2" etc.  Note that the fees of the 

following tranches automatically 

equal the previous tranche unless 

otherwise overtyped.  The first 

tranche is always the net value less 

any other tranches.  This feature can 

not be changed.  Other tranches can 

be added as percentages or lump sum 

values.  We suggest that you use 

percentages if you are looking for 

land value based on a profit and use 

actual values if you know the land 

value and are using CALDES to find 

your profit. 

 

 At the top of the Land spreadsheet is 

other project information.  This will 

not be printed on the land 

spreadsheet, but it can affect the 

display of the appraisal.  The project 

name, the start date and metric or 

imperial units can be changed from 

here too. 

 

 The project start date, (not 

necessarily the land purchase date) 

can be changed here.  For example to 

add March 2001,  type 3/2001  

 
 

 

10.0 OVERALLS 

SPREADSHEET 

 

10.1 Construction fees 

 

 Add in fees as percentages of 

construction costs or whole amounts 

(any figure over 100 is assumed to 

be a whole amount). 
 

 To change the way in which fees 

are dealt with through out your cash 

flow select: "Spreadsheet 

Control-> Overalls-> fees". 

This will give you four options for 

spreading fees: 

Option 1a - Over 5 lump sums: 
Spreads the payment of fees over the 

whole project period. The spread is 

determined by the percentages that 

were entered on the Overalls Default 

Screen in the Setup Wizard, but can 

be edited here. 

 

Option 1b - 5 Stages, spread 

Construction: Takes the total 

percentage of fees allocated to the 

start and finish of the construction 

period and spreads them over the 

construction period on a pro rata 

basis. 

 

Option 2 - % of Construction 

Only: A spread of fees pro rata 

construction costs. 
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Option 3 – Free Type: Unlocks the 

Fees Area on the Cash Flow 

Spreadsheet allowing you to type in 

fees directly to the Cash Flow 

Spreadsheet. 

 

 You can add in more fees by typing 

the label required and entering either 

a % or fixed figure. 

 

 You can detail up to 10 different fees 

here. The Cash Flow will allow 

further flexibility. 

 

 You can create a typical spread of 

fees over the development in the 

"Breakdown of Above" section.  

Always add your worst case scenario 

and then amend it later if required.  

(If this does not provide a detailed 

enough forecast then use the other 

costs bullet payments instead.)  Type 

in the percentage of the fees that you 

expect to be paid in line with the 

main project timings.  For instance if 

you expect to pay 20% of your fees 

at the beginning of construction add 

20% in line with “Construction 

start.”  Check that the total is 100% 

when you have finished. 

 

 

10.2 Planning fee, Building 

regulation fee, Letting fees and 

sale fees. 

 

This section allows you to add overall 

fees for planning, building regulations, 

letting legal and agent fees and sale 

legal and agent fees.  In a mixed use 

scheme units can be excluded from 

letting fees by selecting the appropriate 

unit in the Unit Breakdown Spreadsheet 

and putting a Y or N in row 57. Press 

F6 on your keyboard to show row and 

column headings of the current 

spreadsheet.  Press F7 to hide them 

again. 

 

10.3 Overall Timings. 

Understanding how this section 

works  

 
 The Timing section is for the whole 

project.  You must set these dates 

first and then phase individual units 

in the Unit Breakdown. 

 

 
 

 Planning month is the month from 

the start of the whole project that 

planning is paid for. 

 

 Building Regulations month is the 

month from the start of the whole 

project that Building Regulations is 

paid for. 

 

 Construction start is the month from 

the start of the whole project that the 

first element of construction is paid 

for. 

 

 Repeat? - This allows you to define a 

flat “Monthly” construction cost or a 

number of “S-Curve” options by 

clicking on the grey cell at  

 

ref: D899  and 

selecting from the drop down list 

which will appear below the cell.  

Note the box in the margin - this 

highlights to the user that a drop 

down box is linked to the grey cells 

in that row.  All units will then take 

the same form of construction costs 

unless otherwise specified in the 

Unit Breakdown Spreadsheet.  (Also 

you can type directly over the cash 

flow for a detailed construction cost 

analysis. See Section 12.0)  
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 Construction Months allows you to 

define how long all phases of 

construction take.  If construction 

starts in month 3 and takes 12 

months add 12 here (not 15.)  If you 

have two phases of construction, the 

first starting in month 3 and taking 

12 months and the second starting in 

month 8 and taking 12 months add 

17 here. This can also be done 

automatically with the Phasing Tool 

in the Setup Wizard, for new 

projects. 

 

 Marketing month is the month when 

you expect to pay for marketing.  

Remember that if your marketing is 

complicated it can always be added 

as an other cost, which can then be 

typed over in the cash flow on an “as 

it happens basis.”  This is true of any 

item and is detailed later in the cash 

flow section of this tutorial. (See 

Section 12). 

 

 The void period is the number of 

months from the end of the last 

phase of construction to the very last 

sale. So if you finish construction in 

month 12 and expect to have already 

sold some units, (detailed in the unit 

breakdown sales schedule area,) but 

that it will take another 6 months to 

sell the remaining units, just add 6 as 

your void. Remember that you can 

easily check when items are paid for 

or sold by checking the cash flow 

proceeds. 

 

 The project end date automatically 

calculates how long the whole 

project is currently expected to take, 

from your first payment to your last 

sale.  (Some recoverable VAT may 

be expected after this date however.) 

 

 

10.4 Finance. 

 
 The Finance section allows you to 

change basic interest rates etc.  For 

more detailed multi-layered finance, 

variable on a monthly basis. (See 

Section 12.8). 

 

 

 Compounding is initially fixed as 

monthly, paid at the beginning of the 

following month.  You can however 

change this to Quarterly by selecting 

monthly; the option quarterly will be 

displayed. 

 

 If your cash flow becomes positive 

before the end of your project you 

could earn interest on that money, as 

your bank balance would be positive.  

For valuation purposes you may 

wish to add a positive rate here. 

 

 The negative interest rate that you 

have designated in the “Setup 

Wizard” was automatically sent to 

this cell of the Overalls spreadsheet 

and is currently being used in the 

cash flow.  To change your overall 

interest rate type in a new one here. 

Note that multi-levelled finance, 

variable on a monthly basis, with 

equity, mezzanine, mortgages, 

interest on any single item etc. is 

available in the cash flow, in the next 

tier of the Pyramid System if 

required. 

 

 The Net Present Value discount rate 

(NPV) returns today‟s value of your 



 - 17 - 

profit, based on the annual cash flow 

values before interest at the current 

discount rate. The net present value 

of an investment is today‟s value of 

a series of future payments 

(negatives values) and income 

(positive values). The NPV 

investment begins one period before 

the date of the first annual cash flow 

value and ends with the last annual 

cash flow value.  

 

 The net present value is calculated 

using the following formula: 

1 / ( ( 1 + Discount rate ) ^ ( ( Month 

Number -1 ) / 12 ) ) * monthly net 

cash flow on a monthly basis and 

then added together. This equates 

exactly to the Parry‟s tables and does 

not use any Excel PV or NPV 

formula.  Remember that, unlike 

other systems, all CALDES formula 

are visible (but locked) and available 

for examination.  If you require more 

information about any of our 

calculations please call us. 

 

 Bank arrangement fee.  Easily 

forgotten, this can be added as a 

percentage of your maximum 

borrowing requirement or as an 

actual cost.  Add the date that this 

payment is paid, from the beginning 

of the whole project. 

 

 The VAT rate has come from the 

VAT Defaults sheet at the start of 

the program.  It is shown here for 

printing purposes, but can also be 

changed here.  VAT is applied at this 

rate, recovered on this basis and can 

be seen in the cash flow.  To change 

VAT on whole sections go back to 

the VAT Setup Screen by selecting 

the fourth button from the left at the 

top of the screen (VAT can be 

changed/added to any individual 

item in the Cash Flow. This is 

detailed in the cash flow Section 

12.4. You can even simulate the 

effect of multiple VAT rates using 

our percentage system.)   

 

 

 

11.0 UNIT BREAKDOWN 

SPREADSHEET 

 

 This spreadsheet allows you to 

schedule and fine tune individual 

units.  You are able to change 

specific details such as internal and 

external areas, costs, construction 

dates, marketing, other costs and 

sales, related to specific units. 

 

 Please note that all items added 

here in any one column will be 

shown under the same name in the 

appraisal.  In other words, if you 

have a unit called “B1a Office Unit 

1” then any other costs, marketing 

etc. will be shown as “B1a Office 

Unit 1” in the Other costs section of 

the Appraisal and called “B1a 

Office Unit 1” in the Marketing 

section of the appraisal.  If you want 

to add an item under its own name, 

such as contaminated land, it should 

be added as a bullet payment, using 

the Menu: "Spreadsheet 

Control-> Bullet Payments-> 

Costs", or the Menu: 
"Spreadsheet Control-> Bullet 

Payments-> Proceeds " 

 

 You don‟t have to use this 

spreadsheet just for buildings.  Any 

cost or revenue that needs automatic 

scheduling should be added here.  If 

however the item is a simple cost or 

revenue then use the bullet 

payments, method, as it is less 

demanding on system memory. 

 

 

11.1 Adding more units. 
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 Select the Menu: "Spreadsheet 
Control-> Unit Breakdown-> 

Add new Unit." A new column will 

be added and a pop down box will 

provide you with a selection of 

default units.  Select an item from 

the list. If none of the items provided 

are suitable select the “Blank” option 

and fill out your own details. Also 

see 11.3 Changing a units name, 

below. 

 
11.2 Deleting units.  

 

 Select the column of the unit which 

you want to delete and then select 

the Menu: "Spreadsheet Control-
> Delete selected 

unit/payment/VAT."  You can also 

delete the unit from the Appraisal by 

clicking on the Unit in the Appraisal 

and then the same menu command.  

Note that you can not delete the last 

unit.  Change its use instead (See 

Changing a units use type below). 

Alternatively, you could change the 

number of Sub-Units to zero.  

 

 

11.3 Changing a units name.  

 

 Select the column of the unit which 

you want to change and then select 

the Menu: "Spreadsheet Control-
> Unit Breakdown-> Change 

Unit Name" and then just type the 

name.    The first three rows will all 

be shown in the appraisal.  The name 

will be truncated to 20 letters or 

numbers. 

 

 
 

 You will note that each units details 

are shown twice.  This is so that you 

can see the Current unit even if you 

scroll down to lower rows.  To 

change a unit‟s details you need to 

scroll up to the area shown above 

and select the appropriate row. 

 

 

11.4 Changing a units use type.  

 

 The drop down box symbol 

 is shown next to 

the words “Use Type” in the Unit 

Breakdown spreadsheet. By clicking 

on any grey cell in line with this 

symbol you will be shown a drop 

down box.  In this instance it is the 

use type drop down box, which will 

give you a list of available default 

units.  Click on a new use type. 

 

 
 

 

11.5 Visible and hidden rows. 

 

 The Unit Breakdown is currently set 

up to show only those rows that 

match your particular development 

style (Residential, commercial, 

mixed use.)  You were able to make 

a choice as to which style of 

development you require in the 

Setup Wizard. The available styles 

have a predetermined set up, which 

you are able to customise to your 

requirements.  The images shown 

here are with all available rows 

showing. (See the Defaults 

Spreadsheet Section 15 for 

instructions on how to set up, show 

or hide Unit Breakdown rows.) 
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 Other available sections include a 

proceeds or sales schedule and other 

costs.  See Section 11.10 for further 

details. 

 
11.6 The Unit Description area. 

 

 The top part of the Unit Breakdown 

allows you to add a description of 

the Unit, including: 

 

 
 

 

 Remember that all green text lines 

are our default suggestions, but that 

they can be changed using the Menu: 

"Spreadsheet Control-> Unit 

Breakdown-> Edit Green text." 

 
11.7 The Unit Proceeds area. 

 

 Number of Sub units: This is a 

multiplier.  For example, if you have 

5 identical units, instead of adding 5 

identical columns just add 5 in the 

Number of Sub Units row.  The 

areas, value, costs and construction 

period will be the same for all units.  

You can sell them at different times 

however, using the sales schedule 

outlined later in this section. 

 

 You must have at least 1 Sub-Unit 

for the column to be calculated. 

 

 The net area per unit is hot linked to 

the gross area and changes here will 

automatically prompt you to update 

the gross area too if required.  Note: 

The net area is multiplied by the 

number of sub units in the current 

column. 

 

 Rent/Rate per area or Unit Value 

will automatically differentiate 

between a commercial rent such as 

£15 per square foot, a residential rate 

such as £200 or a Lump sum value 

such as £150,000.  If you are using 

another currency then you may want 

to change the threshold value, i.e. the 

value at which a rate becomes a 

lump sum.  This can be done by 

opening up the calculations section 

using the Menu: "Spreadsheet 
Control-> Unit Breakdown-> 

Proceeds(sales)-> Show Calcs." 

 

 A ground rent can be added. 

 

 A yield can be added to commercial 

units. 

 

 Purchasers acquisition costs and 

purchasers finance costs can be 

added in the usual way.  Purchasers 

acquisition cost can be calculated in 

two ways.  The first is based on the 

unit value and the second is on the 

value at yield.  To examine or 

change the method used see the 

Menu: "Spreadsheet Control-> 

Unit Breakdown-> Proceeds 

(sales)-> Show calcs." 

 
 The letting Legal/Agent row allows 

you to have a mixed use scheme and 

allocate letting fees to some units 

and not to others.  Simply type a Y 

to allocate fees and an N to remove 

fees.  The default for residential 

units is N and for Commercial it is 

Y. 
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11.8 The Unit Costs section. 

 

 
 

 This area starts with unit 

construction. The construction area 

is linked to the internal area and 

changes here will automatically 

prompt you to update the internal 

area too if required.   Note: The 

construction area is multiplied by 

the number of sub units in the 

current column. 

 

 

 The Cost per area/ Total Unit Cost 

allows you to add either a cost per 

square foot or a total unit cost in this 

cell.  CALDES is automatically able 

to differentiate between the two. 

 

 Construction timings for individual 

units.  This performs in exactly the 

same way as in the Overalls 

spreadsheet as outlined in section 

10.3 Overall Timings, but on each 

individual unit.  Initially the dates 

and repeat are the same as in the 

Overalls spreadsheet, but you can 

simply type over the formula with a 

number of your choice.  This allows 

you to phase every unit, which in 

effect allows you up to 255 phases 

per scheme.  You could then add 

other schemes in the Combined Cash 

Flow system for an even wider view 

of your portfolio.  To replace the 

original formula select the cell in 

question and then press the F5 key 

on your keyboard. 

 Note, that if you reduce the length of 

your cash flow to before a date 

which you have fixed here, then 

CALDES will prompt you to check 

these dates. 

 

11.9 Unit Marketing 

 
 Unit marketing is relatively 

straightforward.  Note that all 

marketing entered in this area will be 

automatically placed in the month 

that you have allocated to marketing 

in the Overalls spreadsheet and that 

the marketing will be described as 

belonging to the current unit in the 

appraisal.  If you want to put 

marketing of an item under a 

heading other than the current unit 

then you must add it as a bullet 

payment using Menu: "Spreadsheet 
Control-> Bullet payments-> 

Costs."  Alternatively you may 

select the item in the cash flow and 

move it using the Ctrl Key and the 

arrow keys on your keyboard.  For 

more information see the Cash Flow 

Section 12. 

 

11.10 Unit Other Costs and 

Revenues or Bullet Payments? 

 
 Other costs or revenues can be added 

in two ways.  They can either be 

attached to a unit, being displayed in 
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the appraisal under the units name, 

or they can be bullet payments under 

their own name.   

 

 For bullet payments select the Menu: 

"Spreadsheet Control-> Bullet 

Payments-> Proceeds " or Menu: 

"Spreadsheet Control-> Bullet 

Payments-> Costs."  This will ask 

you for a name, an amount, a date 

and a period of time that you would 

like to spread the payment over.  

Once added you can adjust the 

spread of the cost by typing directly 

into the cash flow for the item 

concerned. 

 

 For payments related to specific 

units you can use the other costs or 

other proceeds sections.  Remember 

that these costs will be shown in the 

appraisal under the current unit name 

and not the name of the cost or 

revenue - use bullet payments as 

described above for named costs or 

revenues. 

 

 The unit other costs and unit other 

proceeds sections use a simple 

process which involves adding the 

total amount, the month that the 

payments start being paid, a period 

to spread the payments across and 

how often those payments repeat 

(monthly, quarterly etc.) 

 

 
 

 In the above example a total cost of 

£10,000 is being paid monthly, 

starting in month 2 for 20 months 

(the 20 is hidden beneath the drop 

down box.  To display the drop 

down box click on the grey Repeat? 

cell.  To confirm that the process is 

understood, have a look in the cash 

flow spreadsheet.  

 

 Cost 1 and Revenue 1 are shown by 

default. Further Costs are accessed 

by the Menu: "Spreadsheet 
Control-> Unit Breakdown-> 

Other Costs -> Show 2"etc. 

 

11.11 Sales schedules 

 

 To schedule sales, we can use two 

methods. Either the default, which 

allows you to type percentages 

directly into the cash flow. This 

though is restricted to only nine 

entries per unit. 

 

 The other option is to fill in a 

schedule sheet, which will appear 

below the unit proceeds section. To 

use this "Spreadsheet Control-> 

Unit Breakdown-> proceeds 

(sales)-> use free type 

(default) and untick this. 

 

 The schedule will appear showing all 

ten receipts. N.B. Receipt 1 is 

always the remainder and will need 

to show a value. 

 

 
 

 Remember that the box next to the 

 indicates a drop down 

box, which can be accessed by 

clicking on any of the grey repeat 

cells in that row. 

11.12 Pre-Sales Income 

 

 To add any income streams to the 

appraisal we need to offset this 

against any of the costs. 

 

 Select "Spreadsheet Control-> 
bullet payment-> rental 
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income". This will give you a pro 

forma, which will allow you to add 

the rental income. 

 

 The rental can be added quarterly, 

but this will not be quarter dates. 

 

 When naming the rental income use 

the unit name and this income will 

appear as a negative cost in the other 

costs section of the main appraisal. 

 

12.0 THE CASH FLOW 

SPREADSHEET 

 

12.1 Cash Flow Overview 

 

 This spreadsheet is where all the 

interest calculations take place.   

Rather than using complex formula 

in the appraisal, we simply cross-

reference our appraisal exactly to our 

cash flow.  This leads to an exact 

match between the two, without the 

danger of upgrades making previous 

spreadsheets unstable.  This also 

guarantees the reliability of our 

sensitivity analysis, especially when 

using multiple variable interest rates. 

 

 Information can be sent to the cash 

flow from other spreadsheets or sent 

to other spreadsheets from the Cash 

Flow (this is automatic). 

 

 Whilst there are limitations to 

exactly where an item can be 

displayed, we have provided the 

flexibility to place any item at any 

date, using our bullet payment 

system, described throughout this 

tutorial.  This means that every 

scenario can be tackled, though some 

may require going deeper into the 

pyramid than others. 

 

 CALDES has provided a host of 

tools to tackle complex cash flow 

scenarios and speed up and simplify 

data manipulation.  In particular, 

CALDES can be used as a project 

monitor, well beyond the initial 

appraisal process. 

 

 

12.2 Cash Flow Date system 

 

 All dates are monthly, but cash flows 

can be displayed quarterly, or 

annually by selecting: "Spreadsheet 
Control-> Cash Flow -> 

View/Monthly/ Quarterly/ 

Annual”. 

   

 You can also change the calculation 

of interest to quarterly or annually by 

selecting: "Spreadsheet Control-
> Cash Flow-> Finance -> 

compounding" 

 

 The current month number and date 

is always shown along the top of the 

cash flow.  To change the start date 

go to the top of the land spreadsheet. 

(See section 9.0)  If the dates appear 

wrong in the cash flow then make 

sure that you have entered the date 

correctly in the land spreadsheet and 

not used a date in the middle of the 

month.  As all calculations are done 

in a monthly cash flow, the above 

entry would not affect your 

calculations. 

 

12.3 The cash flow sections. 

 

 You have three display options.   

 

 The first option automatically hides 

all the rows except the totals for each 

section of payments and costs in the 

cash flow.  This includes total VAT 

and cumulative costs.  A typical 

example would be for the Land 

Section, where only the total 

monthly land cost, the total monthly 

VAT and the cumulative Land cost 

would be shown.  To use this option 

select the: "Spreadsheet Control-
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> Cash Flow-> All Rows -> 

Hide (leave totals only.)" 

 

 The second option automatically 

hides all rows with no information in 

them and shows all rows with 

information in them, including the 

totals in the option above.  However 

it does not show the individual VAT 

rows for each item. This is the 

default option but can be turned off 

using the menu: "Spreadsheet 
Control-> Cash Flow-> All 

Rows -> Show (Reset all 

excluding VAT)" 

 

 The third option shows all rows in 

the above two options, plus each 

individual VAT row. To use this 

option select the menu: 
"Spreadsheet Control-> Cash 

Flow-> All Rows -> Show 

(Reset all excluding VAT)" 

 

 

12.4 VAT in the Cash Flow. 

 

 Having used Option 3 in section 12.3 

above, you are presented with each 

items VAT line, grouped at the 

bottom of each section in the Cash 

Flow.  Only items with VAT are 

shown.  To show an item without 

VAT select the item above and then 

select the menu: "Spreadsheet 

Control-> Cash Flow-> Show 

next row” 

 

 To change the VAT for a row, select 

the VAT row concerned and then 

select the menu: "Spreadsheet 

Control-> Cash Flow-> VAT 

(Current Row)". You will be 

presented with an input box.  Type in 

the percentage of that item which 

will accumulate VAT and the 

percentage recovered. 

 

 
 

12.5 Changing or moving payments 

in the Cash Flow. 

 

 There are three ways of changing or 

moving items in the cash flow.  You 

should thoroughly investigate each 

option and decide which will meet 

your requirements. 

 

 The first is to go to the spreadsheet 

where the item originates. i.e. for 

anything to do with Land go to the 

Month cells for each tranche of Land 

in the Land Spreadsheet, for other 

timings go to the Timings area of the 

Overalls spreadsheet.  (Note that 

phased construction and sales 

timings must be changed in the unit 

breakdown.) This is the preferred 

option, as it keeps the scheduling of 

information automatic, but it is also 

the longest way of doing it.  Using 

this option allows any information to 

be moved or changed. 

 

 The second way is to select the item 

in the cash flow and slide it along in 

time.  The only limitation with this 

method is that you can only move 

white cells.  Select the cell and then 

hold down your Ctrl (Control) key 

on your keyboard.  (Bottom left.)  

The white cell will change to yellow.  

Now press the left or right arrow 

key, keeping the Ctrl key down.  

(There is a slight delay initially.)  

When you let go of the Ctrl key the 

original amount will reappear in that 

cell.  Note that unlike Excel‟s copy 

and paste, if there is a number in the 
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cell already then it will be added to 

the new number, keeping the total 

the same as before.  Only interest 

will be affected.  You can also drag 

the pink bar above each tranche of 

land in the same way.  This will 

move all items in that tranche to a 

new date and change the month in 

the Land spreadsheet too. 

 

 The third option is to type directly 

over the information.  This is also 

limited to white cells, but has a 

second limitation: You can only type 

over cells indicated by a light blue 

(cyan) square in the left margin.  The 

most flexible of these are bullet 

payment rows.  Typing into them is 

just like typing into any normal 

spreadsheet, but with the changes 

being automatically shown in the 

Appraisal and having an affect on 

the interest. Construction cost 

behaves slightly differently.  If you 

type over a construction cost the cell 

changes to cyan.  This means that it 

is a fixed cost, or an “actual” cost.  

Any differences will be spread 

across all non-cyan coloured cells, in 

relation to any S-Curves etc, keeping 

total construction costs the same. 

 

 

 Construction fees can be typed over 

using the menu: "Spreadsheet 

Control-> Overalls-> Fees-

>Opt3-Free Type." 
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12.6 Changing the names of items 

in the cash flow. 

 

 There are two ways of changing 

names. 

 

 The first is for rows with their names 

in green.  To change these select the 

menu: "Spreadsheet Control-> 

Cash Flow-> Edit green text."  

You will then see the name (if any) in 

the edit bar at the top of the screen.  

Just type in a new name. 

 

 All other names, except planning, 

building regulations, letting & sale 

agents and any titles, can be changed 

from the relevant linked spreadsheet.  

In other words to change a Land item 

go to the Land spreadsheet.  To change 

a unit name go to the Unit Breakdown 

spreadsheet.  To change a fee go to the 

Overalls spreadsheet. 

 

 

12.7 Display of cash flow columns 

for printing. 

 

 When you print the cash flow it will 

print all visible columns.  This means 

that if you don‟t want to print a 

particular portion of the cash flow you 

can select any cells in the columns that 

you don‟t want and then select the 

menu: "Spreadsheet Control-> 

Cash Flow-> Hide selected 

columns." 

 

 For a more complex scenario you 

can use the automatic column display 

tool, using the menu: "Spreadsheet 

Control-> Cash Flow->View-> 

Monthly/Quarterly/Annual."   Please 

note that this will not change the actual 

calculations of the cash flow, just the 

display of the rows and columns. To 

change interest calculations use the 

menu: "Spreadsheet Control-> 

Cash Flow -> Finance -> 

compounding." 

 

 
 

 The above box will change the 

display of the cash flow to be shown 

on a monthly basis for the first year, 

a quarterly basis for the second year, 

on the third month in the quarter and 

annually for the last three years in 

the twelfth month of the year.  

Additionally the option to show only 

the cumulative total rows has been 

selected.  The option to show the last 

sale column, whatever month it is in, 

has also been selected.  Finally the 

last column of VAT recovery will 

also be included. 

 

 The above box can also be accessed 

from the Cash Flow options of the 

Printing Selection box by pressing:  

 

 
 

12.8 Complex Finance options, 

using the Cash Flow. 

 

 Until now finance has involved 

simple concepts: We have a single 

rate of interest over the whole 

project, compounding on a monthly 

or quarterly basis. This information 

is entered into the Development Set-

up Wizard at the beginning of the 

appraisal, and can be changed in the 

Finance section of the Overalls 

spreadsheet.  
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 The cash flow allows you to have up 

to four levels of finance, variable on 

a monthly basis, and directly linked 

to any other part of the system.  This 

allows you to find the interest on say 

the land only, or on equity, 

mezzanine finance etc. 

 

 Important! The first source of 

finance is always the remainder of 

your total borrowing requirement in 

any one month.  For example if you 

have £300,000 as equity you could 

add this as source two with an 

interest rate of zero.  If your total 

borrowing in that month was 

£1,000,000 then source 1 would 

automatically be the remainder - 

70% - at it‟s own interest rate. 

 

 The Source 1 percentage can only be 

changed by changing other sources 

of borrowing because it is always the 

remainder!  The others may be 

defined, either as a percentage of 

total borrowing, or a lump sum 

amount. 

 

 

 To set your finance sources select 

the menu: "Spreadsheet Control-
> Cash Flow-> Finance-> Edit 

Source," and select the source in 

question. 

  
 

 Add in the source‟s description. 

 

 Source interest rate: If you want the 

source to automatically be the same 

as your default source, set in the 

Setup Wizard then “Use main 

negative rate”, otherwise select 

“Use other rate” and type in a new 

interest rate. 

 

 Source 1: Having set the description 

and interest rate you should press 

“Add and finish.” You can not add a 

borrowing amount or percentage, as 

source 1 is always the remainder of 

your total borrowing requirement. 

 

 Source 2 or greater: You can also 

add in your borrowing requirement 

and the date at which it enters your 

cash flow. Unlike your main Source 

(1) you can assign Sources 2 - 4 to 

be either a percentage of total 

borrowing or a percentage of the 

land value, or first in last out option; 

this is done in the bottom part of the 

Finance Dialogue Box. Once all 

changes have been made click “Add 

and finish.” 
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 Once the sources are visible in the 

cash flow you don‟t need to use the 

pop up boxes.  You can select the 

cell that you want to change and just 

type over it. CALDES will prompt 

you with any irregularities in your 

payments. 

 

 To reset a row, select the row in 

question and then use the menu: 

"Spreadsheet Control-> Cash 

Flow->Replace/mend current 

row." 

 

 How do I choose the interest rate 

chargeable on the equity input or a 

nil interest rate?  Select the menu:  

"Spreadsheet Control-> Cash 

Flow-> Finance-> Edit Source 

2," type in the description of the 

equity, a rate of 0, the amount of 

equity in amount/% and when that 

equity is first used in the month box.  

Then press add and finish and check 

the cash flow. 

 

 How do I evaluate the interest on a 

standard loan, over a fixed period 

and ignore the drawdown and 

payback features of the CALDES 

cashflow? Select the menu:  

"Spreadsheet Control-> Cash 

Flow-> Finance-> Edit main 

source," and add an interest rate of 

0. Then select the menu:  

"Spreadsheet Control-> Cash 

Flow-> Finance-> Edit Source 

2," and add in the amount of the loan 

and when it happens.  Check the 

positive rate too - you may want to 

reduce it to 0. 

 

 How do I set up complex finance 

deals with formula related to various 

parts of the system? Use the cash 

flow notes and formula section at the 

bottom of the cash flow.  Please call 

for more information. 

 

13.0 THE PROPRIETARY 

SPREADSHEET 

 

 No other Development Appraisal 

Software allows you to customise 

your own spreadsheets and link them 

into the system! 

 

 CALDES on the other hand gives 

you a blank spreadsheet with 

Microsoft Excel formatting and 

functionality without the need to buy 

Excel itself. You can then save any 

spreadsheet and load it into Excel. 

 

 To customise your own spreadsheet 

select the menu:  "Spreadsheet 
Control-> Proprietary->(and 

then make a selection) " 

 

 Much of the system can be linked in 

and out of this spreadsheet by 

selecting a blank cell and pressing 

the equals key and then clicking on 

the cell reference which you want to 

connect to.  When connecting to 

other spreadsheets, you should be 

aware that cell references move 

when more units are added.  To 

combat this you need to use the 

OFFSET formula or Named Cells.  

For more information please contact 

CALDES. 

 

 You can build up your own mini 

appraisal by connecting to the 

floating eye spreadsheet.  For more 

information please call CALDES. 

 

 You can copy and paste information 

to and from the proprietary 

spreadsheet using the Windows 

clipboard.  Select the area to copy 

and then select the menu: “Edit-> 

copy...” or “Edit-> Paste....” 
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 You can import the Appraisal 

Spreadsheet in to properties by 

selecting “File-> Propriety-> 

Import Current Spreadsheet” 

 

 

 Important! Proprietary spreadsheets 

are saved separately from the other 

spreadsheets.  Remember to click the 

“Save Proprietary” Button in the 

“Save dialogue box.” 

 

 

14.0 SENSITIVITY- 

ANALYSIS  

 

 To run the sensitivity analysis, select 

the Sensitivity Spreadsheet.  You 

will be presented with a number of 

options. 

 

 To change an option, click on the 

drop down arrow and then select an 

option. 

 

 Decide on which unit to include in 

the sensitivity. 

 

 Decide on the number of steps 

required for each variable – these 

must be an odd number as the 

middle number is the current answer. 

 

 When the required variables have 

been set click Run Sensitivity. 

 

 Running the sensitivity analysis is a 

relatively slow procedure, but the 

method used by CALDES is an 

important feature of our system.  On 

a Pentium 75Mhz with a simple 

scheme the sensitivity should take 

under a minute for profit and two 

minutes to work out land values. 

This is because we don‟t use 

formula to approximate our cash 

flow.  We have found this to be too 

unreliable when using multiple 

variable interest rates or when 

issuing upgrades.  Having run the 

sensitivity analysis you can put the 

figures from one of the options back 

into the system and be guaranteed 

that you will achieve the same 

results.  This is because all figures 

are taken from real cash flows. 

 

 You can stop the Sensitivity 

Analysis at any time by clicking the 

stop button that appears on your 

screen while the Sensitivity Analysis 

is running. 

 

 On stopping the Analysis CALDES 

asks if you would like to return to 

your original appraisal before the 

analysis was run or, if you would 

like to insert the last sensitivity 

analysis calculated. 

 

 

15.0 The UNIT 

DEFAULTS 

SPREADSHEET 

 

 This spreadsheet allows you to set up 

your own default starting figures for 

each standard unit type. 

 

 It also allows you to determine how 

items are displayed in the unit 

breakdown when you select a 

Residential Setup Style or a 
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Commercial Setup Style in the Setup 

Wizard. 

 

 To change a unit‟s default starting 

figure scroll across to the use type 

required and then type in the new 

default value. 

 

 To change a setup style scroll across 

to the use type required such as 

residential and then click on the row 

that you don‟t want displayed in the 

column that you want to change.  If 

the cell has the words 

then on it will 

remove the words “Hide Row” 

and the row will be 

displayed at start up.  It is a simple 

toggle.  Also it will change the 

current setup in your unit 

breakdown. 

 
 

 

16.0 PRINTING 

 

 To print select the menu: "File-> 

Print All" 

 

 

 

 You will be shown a print box with a 

number of options.  To print all the 

spreadsheets click the button below. 

 

 
 

 To print individual sheets select the 

appropriate tab. 

 

 
 

 Each tab will have three standard 

buttons: Page Setup, Print Setup and 

Print. 

 

 Some tabs will have additional 

functions related to the specific 

spreadsheet. These will be functions 

already covered in other sections, but 

given as a reminder here. 

 

 Page Setup: This is a standard page 

setup dialogue box with areas for 

headers, footers & margins for 

logo‟s etc. 

 All new projects will have our 

standard setup.  When you save a 

project any changes will be saved 

with that project, but any new 

projects will remain as our default 

settings.  If you need to change the 

default file please call. 

 

 Please note that colour changes, 

reformatting and the addition of 

boarders etc. can all be done, but 

they require a little care, depending 

upon what you intend to do.  For this 

reason we recommend that you 

contact us once you are familiar with 

other features of the program and we 

will guide you through these 

additional functions. 
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 You can also determine the page 

positioning, colour, scale etc.  Please 

note that fit to pages overrides the 

scale option. 

 

 Print setup allows you to change the 

page orientation, the current printer 

and any other network or printing 

options. 

 

 
 

 When these settings are correct for 

the current spreadsheet press the 

Print button 

 

 Print any other spreadsheets and 

then press the “Done” tab to finish 

printing. 

 

 

17.0 FILES: SAVING, 

OPENING AND NEW 

PROJECTS 

 

 To save a file select the menu: 

"File-> Save" You will see the 

following box. 

 

 
 

 Type in the project name.  (Up to 8 

letters) 

 

 You can add up to 99 options with 

the same file name. The option 

number will be added after the letter 

a. e.g. project.a12 would be option 

12 of a file called project. 

 

 To save the full project click the 

“Save spreadsheet” button.  This will 

save all the spreadsheets except the 

proprietary and the sensitivity.  Each 

spreadsheet is actually saved 

separately but only one file (the 

appraisal, and hence the letter a) is 

shown to reduce the size of the list. 

 

 Important!  The Proprietary 

spreadsheet is saved separately from 

the other sheets, as it often does not 

contain any information. This 

reduces the space required on your 

hard disk.  To save the Proprietary 

spreadsheet click the “Save 

Proprietary” button. 

 

 You can also add in new directories 

and save them as the default save 

directory. 

 

 You can delete a project by selecting 

the project and pressing the “delete 

project” button. 
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18.0 FREQUENTLY 

ASKED QUESTIONS 

 

 Can I incorporate my Excel/Lotus 

spreadsheet appraisals? Yes, but 

the file must be saved as an Excel 

version 4 file.  Any later version of 

Excel can save the file as version 4 

using the Save As option.  To use 

Lotus files in CALDES load them 

into Excel first and save them as 

version 4 Excel files.  We are able to 

do this for you on request.  

 

 Later versions of Lotus can read 

Excel files direct. 

 

 I only handle simple single building 

projects, CALDES seems to be a 

sledgehammer to crack a walnut? 

CALDES is in use by a large number 

of small developers who require 

quick, simple, professional solutions 

in a reliable format, to anything from 

single houses to large factories.  The 

inherent flexibility of CALDES is 

able to respond as the requirements 

grow for more sophisticated 

solutions, involving various sources 

of finance and providing project 

monitoring capabilities. 

 

 Can I return to the development set 

up area / Wizard?  Yes, but as it‟s 

name suggests it is for setting up the 

development only.  All changes to 

the current project should be made in 

the spreadsheets themselves.  Return 

to the development spreadsheet by 

clicking on the button four from the 

left: 

 
 

 Can I cut and paste into other 

documents?  Yes, but only from the 

proprietary and cash flow 

spreadsheets.  If you want to copy 

from other sheets.  There are 

exceptions to this rule and other 

more complex ways of doing this 

too, beyond the scope of this manual.  

If you require further information 

please call CALDES. 

 

 What flexibility do I have in the 

presentation of any part of the 

appraisal, including font type and 

size? You may also load any of our 

spreadsheets into the proprietary 

sheet or Excel and change them, but 

we recommend that you always use a 

copy of the original. 

 

 Why are there two ways of dealing 

with other costs?  One option is for a 

cost on the whole project, the other 

is for costs related to specific units.  

(See section 11.9 Unit Other Costs 

and Revenues or Bullet Payments.) 

 

 When you type information directly 

into the Construction costs of the 

Cash flow why does it prompt me as 

to whether I want to keep those costs 

when ever I change the Unit 

Breakdown?  You are now using the 

cash flow as a project monitoring 

tool.  CALDES is warning you that 

you have typed in project “actuals” 

and that you should not change 

them.  If you don‟t want to use this 

feature, don‟t type into the 

construction cost area of the cash 

flow - change it from the unit 

breakdown instead.  (For more 

information see 11.7 The Unit Costs 

area and 12.5 Changing or moving 

payments in the Cash Flow). 

 When I add up all the Construction 

start, the construction months and 

the void in the timings in the 

Overalls spreadsheet why is the 

project end date one month later 

than I would expect?  
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In the above example construction 

starts in month 3 and continues for 

12 months. (3,4,5,6,7,8,  

9,10,11,12,13,14) plus a void of 6 

months (15,16,17,18,19,20), with the 

project income being at the 

beginning of the following month 

(21) 

 

 How do I alter the database to my 

particular setup? There are two 

areas, the first for Unit defaults and 

the second for Overalls and VAT 

including fees, rates and timings.  

For Unit Defaults see section 15. 

 

How do I enlarge my Cash Flow 

print out? Go to the Cash Flow Tab 

on the Print Menu Screen (see 

Section 16.0) and click on the “Print 

Setup” button. Depending on the 

number of rows of information that 

you want to select the appropriate 

page orientation: For Cash flows that 

contain a lot of units or fees etc 

select “Portrait” for larger text. Click 

“OK” and then click on the “Page 

Setup” button. 

 

 
 

Click on the “Fit to Page” box, so 

that the cross disappears. Then select 

the how many pages you want to 

spread your cash flow over. Click on 

“OK” and print as described in 

section 16.0. 
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FAQ’S 
 

QUESTION: What does the „Worst Case‟ figure in the appraisal mean?  Where does it come from? 

 

ANSWER: This is the total cost of the project including finance, i.e. the amount of money that you will 

require for the project including finance and interest on the finance.  Note that the appraisal only shows 

the interest on the finance, not the finance itself, because that is what is used to fund all the other costs.   

 

Where is it in the cash flow?  It is usually in the last month of the project.   

 

Calculation: Worst case total borrowing plus cumulative negative interest. E.g. In the cash flow go to the 

last month and add up all the different sources of finance (E.g. Source 1, Source 2 etc.)  Then add the 

cumulative negative interest for each of those sources
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